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To the Reader  

 

Welcome to g.tec’s world of medical and electrical engineering! 

Discover the only professional biomedical signal processing platform under MATLAB and 

Simulink. Your ingenuity finds the appropriate tools in the g.tec elements and systems. 

Choose and combine flexibly the elements for biosignal amplification, signal processing and 

stimulation to perform even real-time feedback. 

 

Our team is prepared to find the better solution for your needs. 

Take advantage of our experience! 

 

Dr. Christoph Guger Dr. Guenter Edlinger 

 

 

Researcher and Developer 
 

Reduce development time for sophisticated real-time applications from month to hours. 

Integrate g.tec's open platform seamlessly into your processing system. 

g.tec's rapid prototyping environment encourages your creativity. 

 

Scientist 
 

Open new research fields with amazing feedback experiments. 

Process your EEG/ECG/EMG/EOG data with g.tec's biosignal analyzing tools. 

Concentrate on your core problems when relying on g.tec's new software features like ICA, 

AAR or online Hjorth's source derivation. 

 

Study design and data analysis 
 

You are planning an experimental study in the field of brain or life sciences? We can offer 

consultation in experimental planning, hardware and software selection and can even do the 

measurements for you. If you have already collected EEG/ECG/EMG/EOG, g.tec can analyze 

the data starting from artifact control, do feature extraction and prepare the results ready for 

publication. 



User Manual g.ECGtoolbox 5.16.02  4 

Preface 
 

This section includes the following topics: 

 

Required Products 

 

Using This Guide - Suggestions for reading the handbook 

 

Conventions - Text formats in the handbook 
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Required Products 

g®.ECGtoolbox uses: 

g®.BSanalyze – the advanced biosignal analysis software package from g.tec 

 

MATLAB – as basic matrix operation platform  

Signal Processing Toolbox - to give access to standard signal analysis tools 
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Using This Guide 

Chapter “Running g.BSanalyze” shows how to start the Data Editor. 

 

Chapter “Detecting QRS Complexes” shows how to work with the Complex Detector and 

how to manually edit the ECG data. 

Chapter “Calculating a Heart Rate Feature Channel” explains the generation of a heart rate 

channel that is also visible in the Data Editor. 

Chapters “Heart Rate Variability Time Domain Measures”, “Heart Rate Variability Frequency 

Domain Measures” and “Heart Rate Variability Maps” explain in detail how to calculate the 

most important parameters in heart rate variability analysis based on the example of a tilt-

table experiment. 

Chapter “Help” explains the usage of the on-line help, the printable documentation and the 

function help. 

Chapter “Batch-Mode” shows how to use the g.BSanalyze commands from the MATLAB 

command line. 
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Conventions 

 

Item Format Example 

MATLAB code  Courier to start simulink, type  
simulink 

String variables Courier italics set(P_C,'PropertyName',...) 

Menu items Boldface  Select Save from the File menu. 
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Hardware and Software Requirements 
 

For Hardware and Software Requirements see the g.BSanalyze manual. 



User Manual g.ECGtoolbox 5.16.02  9 

Running g.BSanalyze 

After starting MATLAB and setting the correct path, type:  

 
gbsanalyze  

 

in the MATLAB command line 

 

g.BSanalyze starts with a blank data window. 
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Detecting QRS Complexes 
 

 

The first step in ECG analysis is to find the QRS complexes in the time series. The algorithm 

finds a number set that corresponds to the temporal position of successive QRS complexes in 

the ECG. Time differences between adjacent QRS complexes can be shown as Tachogram 

(successive RR interval values are plotted against the ‘beat number’).  

 

The implemented QRS detector bandpass filters and squares the ECG signal. Then a threshold 

detector identifies the QRS complexes.  

Complex Detector Window 

 

The Complex Detector window has the following control elements: 

 

Use complex markers – use already assigned markers to generate a heart rate feature channel 

 

Use input channel – specify an ECG channel to detect QRS complexes 

 

Advanced settings: 

 

Bandpass filter: 

 

 Lower cutoff frequency – defined in Hz 

 Upper cutoff frequency – defined in Hz 

 

Threshold – the level when a QRS peak is detected in mV 

 

Accepted heart rate change: 

 

Min – a QRS complex is only accepted if the actual RR interval is not  

smaller  than e.g. 60 % of the previous interval 

Max – the complex is rejected if the RR interval is longer than e.g. 140 % of 

the previous interval 

Highest accepted heart rate – the QRS detector does not accept heart rates 

above this level 

 

Generate marker names: 

 

Detected events – assign QRS markers to the detected events 

 

Generate feature channel – adds a new heart rate channel to the raw-data. The scaling can 

be in ms, samples or beats per minute. 
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Example 
 

1. Click on Load Data under the File menu of g.BSanalyze and select the file Vasalva.mat 

from  

 
Documents\gtec\gBSanalyze\testdata\TiltTable 

 

2. Press Open to load the data file of a tilt table experiment. 

 
 

 

Channel 1 shows the recorded ECG derivation, channel 2 the trigger signal which indicates 

the time point when the subject was standing up. The subject was lying on a table from 

second 1 to 633 and was standing from second 633 until 1490. 
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3. Select the Complex Detector from the ECG menu to open the following window: 

 

 
 

4. Select the radio button Use input channel to search for QRS complexes and press Select 

input channel… 
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5. Add the ECG channel to the Selected channels list box by pressing the Add to List -> 

button and confirm the selection with the OK ! button. 
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6. Press the Advanced settings… button to open the following window: 

 

 
 

The QRS detector uses bandpass filter to remove artefacts. Enter a Lower cutoff 

frequency of 10 Hz and an Upper cutoff frequency of 60 Hz. Set the Threshold to 0.5 

mV.  

 

The Accepted heart rate change Min should be set to 60 % and the Max to 140 %. The 

algorithm allows therefore only RR intervals which increase or decrease by 40 % 

compared to the previous interval.  

 

Set the Highest accepted heart rate to 180 beats per minute. 

 

7. Confirm the settings with the OK button. 

 

8. To assign QRS markers to the detected QRS complexes check the Detected events box.  

 

9. Press the Start button to search for the QRS complexes.  

 

The QRS markers are assigned to the data in the Data Editor. Use the slider to investigate 

the detection accuracy.  
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10. Click on Marker under the Header menu to see the amount of assigned QRS markers. 

 

 
 

The algorithm with the specific settings detected 1670 QRS complexes. Mark the 

QRS/1670 line in the Counter list box and press the Remove selected marker button.  

 

11. Close the window with the OK button. All makers are deleted in the Data Editor. 
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12. Open the Complex Detector again and set under Advanced settings… the Threshold to 

0.2 mV. 

 

 
 

 

13. Confirm the settings with the OK button and search again for the QRS complexes. 
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Open the Marker window from the Header menu: 

 

 
 

With the modified settings the method has now detected 1667 QRS complexes. Therefore, 

the threshold was too low to find all QRS complexes correctly. 
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14. Scroll in the Data Editor to second 628 

 

 

The algorithm missed 3 QRS complexes because of the movement artefacts in the ECG 

data caused at the time when the subject stood up.  
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15. Click on the Select… button in the MARKERS / ATTR. field of the Data Editor and 

select the QRS marker. 

 

 
 

16. Confirm the selection with the OK button. 

 

17. Assign the correct QRS markers manually by clicking next to the R-peak of each QRS 

complex. 
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18. Select Save as… under the File menu and store the edited data-set under  

DataCorrected.mat in  
 

Documents\gtec\gBSanalyze\testdata\TiltTable 
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The following code show how to perform the example demonstrated above from the 

MATLAB command line. 
 
%Load Data 

P_C=data; 

File=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\Vasalva.mat']; 

P_C=load(P_C,File); 

 

% Complex Detector 

SelectInput = ['channel']; 

ChannelExclude = [2]; 

Method = ['QRS detector BP']; 

Parameters.BP = [10  60]; 

Parameters.Threshold = [0.5]; 

Parameters.IntervalMin = [60]; 

Parameters.IntervalMax = [140]; 

Parameters.MaxBPM = [180]; 

MarkerName.Accepted = ['QRS']; 

Feature.Generate = [0]; 

Feature.Scaling = ['ms']; 

Feature.Replace = ['add channel']; 

Feature.FileName = ['']; 

ProgressBarFlag = 0; 

[P_C] = gBScomplexdetector(P_C,... 

    SelectInput, ChannelExclude, Method, Parameters, MarkerName,... 

    Feature, ProgressBarFlag);ProgressBarFlag = 0; 

 

% Complex Detector 

SelectInput = ['channel']; 

ChannelExclude = [2]; 

Method = ['QRS detector BP']; 

Parameters.BP = [10  60]; 

Parameters.Threshold = [0.2]; 

Parameters.IntervalMin = [60]; 

Parameters.IntervalMax = [140]; 

Parameters.MaxBPM = [180]; 

MarkerName.Accepted = ['QRS']; 

Feature.Generate = [0]; 

Feature.Scaling = ['ms']; 

Feature.Replace = ['add channel']; 

Feature.FileName = ['']; 

ProgressBarFlag = 0; 

[P_C] = gBScomplexdetector(P_C,... 

    SelectInput, ChannelExclude, Method, Parameters, MarkerName,... 

    Feature, ProgressBarFlag);ProgressBarFlag = 0; 
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Calculating a Heart Rate Feature Channel 
 

The Complex Detector window allows to add a heart rate feature channel to the raw-data in 

the Data Editor. Follow these steps: 

 

1. Click on Load Data from the File menu and select the file DataCorrected.mat from 
 

Documents\gtec\gBSanalyze\testdata\TiltTable 

 

The Data Editor shows the ECG channel with the already assign QRS markers. 

 

2. Open the Complex Detector window from the ECG menu and select QRS under Use 

complex marker to use the markers as input for the feature channel generation. If the 

QRS complexes are not already detected select Use input channel for the calculation. 

 

3. Activate the Generate feature channel checkbox and select as Scaling beats per 

minute (1/min). 

 

4. Check the Add new channels radio button and press Start. 

 

5. The Data Editor shows now a third channel which is the heart rate in beats per minute. 

Deactivate the Markers in the SHOW field of the Data Editor. 

 

 
 

6. Set the Seconds in the DISPLAY field to 1490 to show the total recording. 
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Channel 3 displays the increase in heart rate when the subject changes position from lying 

on the table to standing.. 

 

7. To quantify the increase in heart rate click the Ruler button in the TOOLS field and drag 

the horizontal ruler lines to a segment where the subject is lying on the table and to a 

segment where the subject is already standing. 

 

 
 

8. The ruler measures an increase in heart rate of around 28 beats per minute. 
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The following code show how to perform the example demonstrated above from the 

MATLAB command line. 

 
%Load Data 

P_C=data; 

File=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\DataCorrected.mat']; 

P_C=load(P_C,File); 

 

% Complex Detector 

SelectInput = 'QRS'; 

ChannelExclude = []; 

Method = 'QRS detector'; 

Parameters.Wavelet = 'MEXICAN'; 

Parameters.CenterFreq = 30; 

Parameters.MAWindow = 200; 

Parameters.DecisionLevel = 2.5; 

Parameters.IntervalMin = 60; 

Parameters.IntervalMax = 140; 

Parameters.MinBPM = 30; 

MarkerName.Accepted = ''; 

MarkerName.Rejected = ''; 

Feature.Generate = 1; 

Feature.Scaling = 'BPM'; 

Feature.Replace = 'add channel'; 

Feature.FileName = ''; 

ProgressBarFlag = 0; 

[P_C] = gBScomplexdetector(P_C,... 

    SelectInput, ChannelExclude, Method, Parameters, MarkerName,... 

    Feature, ProgressBarFlag); 
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Heart Rate Variability Time Domain Measures 
 

Time domain methods determine either the heart rate at any point in time or determine the 

intervals between successive complexes. In a continuous ECG recording the normal-to-

normal (NN or RR) intervals can be determined (interval from one QRS complex to the next). 

This measures can be used to investigate variations of the heart rate secondary to tilt, Valsalva 

manoeuvre or to describe the difference between night and day,… 

 

Time Domain Measures 

The simplest parameters are the time domain measures: 

MeanRR…mean RR interval in [ms] 

MeanHR…mean heart rate in [1/min] 

MaxRR…longest RR interval in [ms] 

MinRR…shortest RR interval in [ms] 

MinMaxRRDiff…difference between the longest and the shortest RR interval in [ms] 

 

Statistical methods derived from RR intervals: 

SDNN…standard deviation of RR interval [ms] 

Note that the segments used to derive the SDNN measures should be standardized to 5 

minutes or to 24 hours to make comparisons possible. 

SDHR…standard deviation of heart rate (HR) in [1/min] 

 

Segmented Measures 

Statistical measures calculated from segments of the total recording: 

SDANN…standard deviation of the averages of RR intervals in all segments of the recording 

in [ms] 

SDNNindex…mean of the standard deviation of all RR intervals in all segments of the 

recording in [ms] 

The segment length is normally set to 5 minutes. The SDANN measures the changes in heart 

rate due to cycles longer than 5 minutes. The SDNNindex measures the variability due to 

cycles shorter than 5 minutes. Note that the segment length must be specified to be able to 

interpret the result properly. 

 

RR Difference Measures 

Statistical methods derived from differences between RR intervals: 

RMSSD…the square root of the mean of the square of differences between adjacent RR 

intervals in [ms] 

SDSD…standard deviation of differences between adjacent RR intervals in [ms] 

NN50…number of RR intervals differing by more than 50 ms  

pNN50…NN50 divided by the total number of RR intervals in [%] 

 

Geometric Measures 

HRVindex…total number of RR intervals divided by the number of RR intervals which 

correspond to the highest bin in the histogram. Note that the bin width of the histogram must 

be specified to interpret the measure (e.g. 1/128). 
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HRV Time Domain Window 

 

The HRV Time Domain window has the following control elements: 

 

Use complex marker – define the marker that is already assigned to the QRS complexes 

(manually or with the Complex Detector) 

 

Specify DATA INTERVAL: 

 

Start interval at – define the start time point for the calculation 

End at – define the end point of the interval used for the calculation 

 

Tachogram unit – the unit of the calculated tachogram can be in ms, samples or beats 
per minute 

 

Resample tachogram – normally the QRS complexes are not uniformly sampled. Check the 

box to resample the RR intervals by 4 Hz. 

 

Interval length (segmented measures) – define the segment length for the SDANN and 

SDNNindex calculation 

 

Histogram unit – the histogram can be shown in ms or beats per minute. If beats per 

minute is selected than the histogram bins are of width 1 beat per minute. If ms is selected 

than the Bin resolution must be specified. 

 

Bin resolution – defines the width of the histogram bars. The Bin resolution effects also the 

HRVindex calculation.  

 

Correct RR-intervals: 

 

Min – a QRS complex is only accepted if the actual RR interval is not  

smaller than e.g. 60 % of the average interval 

Max – the complex is rejected if the RR interval is longer than e.g. 140 % of the 

average interval 

 

Example 
 

1. Click on Load Data from the File menu and select the file DataCorrected.mat from 
 

Documents\gtec\gBSanalyze\testdata\TiltTable 

 

The Data Editor shows the ECG channel with already assign QRS markers. 
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2. Open the HRV Time Domain window from the ECG menu and select under Use 

complex marker QRS. 

 

 

3. Specify the DATA INTERVAL for the lying period from the beginning until second 632. 

 

4. Set the Tachogram unit to bpm and check Resample tachogram. 

 

5. Enter under Interval length 5000 ms. This interval is used for the segmented measures 

calculation. 

 

6. Set the Histogram unit to bpm. In this mode the Bin resolution is automatically set to 1 

for the histogram presentation. For the HRVindex calculation enter a Bin resolution of 

7.8125 ms. 
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7. Check the Correct RR-intervals box to eliminate intervals which are below 60 % or 

above 140 % of the average interval. 

 

8. Check Show with Result2D to open the graphical output of the calculation with 

g.Result2D. 

 

9. Check Save results to save the calculation result to harddisk. The Automatic treemaker 

creates a subdirectory hrvtd. Enter TiltTable.mat as filename. 

 

10. Start the calculation. g.Result2D opens automatically with the calculation result: 

 

 

 

The green line in the top-left plot represents the tachogram in beats per minute and 

seconds. The blue bars in the top-right plot represent the histogram where the beats per 

minute are counted with a bin size of 1. 

 

The bottom-half shows the Time Domain Measures, Geometric Measures, RR 

Difference Measures and Segmented Measures. 
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11. Perform the same calculation for the second part of the data (standing period). Enter under 

Start interval at 634 seconds and under End at 1490 seconds.  

 

12. Change the filename to TiltTable2.mat and Start the calculation. 
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13. g.Result2D shows the analysis of the standing period: 
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The following code show how to perform the example demonstrated above from the 

MATLAB command line. 
 
%Load Data 

P_C=data; 

File=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\DataCorrected.mat']; 

P_C=load(P_C,File); 

 

%HRV time domain 

MarkerName='QRS'; 

Interval=[1  161792]; 

Tachogram.Unit='bpm'; 

Tachogram.Sampling=['yes']; 

IntervalLength=1280; 

Histogram.Unit='bpm'; 

Histogram.Bins=7812.5; 

CorrectIntervals=[60  140]; 

FileName=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\TiltTable.mat']; 

ProgressBarFlag=0; 

H_O=gBShrvtimedomain(P_C,MarkerName,Interval,Tachogram,... 

IntervalLength,Histogram,CorrectIntervals,FileName,... 

ProgressBarFlag); 

 

%HRV time domain 

MarkerName='QRS'; 

Interval=[162304  381440]; 

Tachogram.Unit='bpm'; 

Tachogram.Sampling=['yes']; 

IntervalLength=1280; 

Histogram.Unit='bpm'; 

Histogram.Bins=7812.5; 

CorrectIntervals=[60  140]; 

FileName=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\TiltTable2.mat']; 

ProgressBarFlag=0; 

H_O=gBShrvtimedomain(P_C,MarkerName,Interval,Tachogram,... 

IntervalLength,Histogram,CorrectIntervals,FileName,... 

ProgressBarFlag); 
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Heart Rate Variability Frequency Domain Measures 
 
Power spectral density (PSD) is a measure of how power in a signal changes as a function of 

frequency. The spectral analysis detects periodic oscillations (amplitude and frequency) and 

has been employed in a great variety of signal processing applications. The heart rate 

variability (HRV) has oscillations at different frequencies that are originated by different 

physiological systems. The parasympathetic and sympathetic systems transmit the oscillations 

to the heart. High frequency oscillations are vagally mediated and low frequency oscillations 

are due both parasympathetic and sympathetic systems. The sinorespiratory arrhythmia is 

vagal mediated and has a frequency synchronous to the respiratory cycle (between 0.2 and 

0.35 Hz). The oscillation due to baroreflex (around 0.1 Hz) is related to the vasomotor system 

and is synchronous to the Mayer waves at the pressure signal. Very low frequency 

components are associated with slow regulation mechanisms such as humoral and 

thermoregulation factors. 

To analyze the oscillations a PSD analysis is performed with parametric (autoregressive 

model, AR) or non-parametric (FFT, Fast Fourier Transformation) methods. Because of the 

high degree of randomness of the RR signal, the autoregressive model is preferable. Then the 

power spectrum is divided into bands to quantify the energy in each one. 

Absolute Measures 

4 main spectral components are extracted from a calculated spectrum: 

ULF…ultra low frequency components in [ms2] 

VLF…very low frequency components in [ms2] 

LF…low frequency components in [ms2] 

HF…high frequency components in [ms2] 

The distribution of the LF and HF frequencies are not fixed and vary with the autonomic 

modulations of the heart rate. The energy in HF is vagal mediated, the energy in LF and VLF 

are due to both sympathetic and parasympathetic systems.  

 

Relative Measures 

ULF, VLF, LF AND HF ARE NORMALLY MEASURED IN ABSOLUTE POWER VALUES. THE 

FOLLOWING MEASURES ARE NORMALIZED BY THE TP (TOTAL POWER) MINUS THE VLF 

COMPONENT AND ARE REPRESENTED IN NORMALIZED UNITS [N.U.] 

LFNORM…LF/(TP-VLF)*100 IN [N.U.] 

HFnorm…HF/(TP-VLF)*100 in [n.u.] 

LF/HF…ratio of LF and HF 

The normalization minimizes the effect of changes in TP on LF and HF. 

 

For short-term recording (e.g. 2 to 5 min) normally VLF, LF and HF are specified. Note that 

VLF is difficult to interpret for such short segments. For long-term recordings (24 h) also the 

VLF and ULF components can be considered. 
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HRV Frequency Domain Window 

 

The HRV Frequency Domain window has the following control elements: 

 

Use complex marker – define the marker that is already assigned to the QRS complexes 

(manually or with the Complex Detector) 

 

Specify DATA INTERVAL: 

 

Start interval at – define the start time point for the calculation 

End at – define the end point of the interval used for the calculation 

 

Tachogram sampling frequency – the RR intervals are resampled with the defined sampling 

rate before the spectral analysis is performed. 

 

Correct RR-intervals: 

 

Min – a QRS complex is only accepted if the actual RR interval is not  

smaller than e.g. 60 % of the average interval 

Max – the complex is rejected if the RR interval is longer than e.g. 140 % of the 

average interval 

 

ULF – calculate the power in the ultra low frequency band (e.g. 0.003 Hz) 

VLF - very low frequency band (0.003 – 0.04 Hz) 

LF – low frequency band (0.04 – 0.15 Hz) 

HF – high frequency band (0.15 – 0.4 Hz) 

 

Method – the spectral analysis method can be FFT (non-parametric) or Burg, Yule Waker or 

Music (parametric methods). 

NFFT – specify the FFT points used for the spectral analysis for the non-parametric and 

parametric methods 

Overlap – specify the FFT segment overlap for the FFT analysis 

Order – specify the autoregressive model order for the parametric methods 

Windowing function – select a hanning, hamming or boxcar window for the FFT 

analysis 

 

 

Example 

 

1. Click on Load Data from the File menu and select the file DataCorrected.mat from 
 

Documents\gtec\gBSanalyze\testdata\TiltTable 

 

The Data Editor shows the ECG channel with already assign QRS markers. 
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2. Open the HRV Frequency Domain window from the ECG menu and select under Use 

complex marker QRS. 

 

 

3. Specify the DATA INTERVAL for the lying period from the beginning until second 632. 

 

4. Enter as Tachogram sampling frequency 2 Hz. 

 

5. Check the Correct RR-intervals box to eliminate intervals which are below 60 % or 

above 140 % of the average interval. 
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6. Enter under ULF 0.003 Hz, under VLF 0.04 Hz, under LF 0.15 Hz and under HF 0.4 

Hz. 

 

7. Select the parametric Method Burg with an NFFT length of 256 samples and an Order 

of 10. 

 

8. Check Show with Result2D to open the graphical output of the calculation with 

g.Result2D 

 

9. Check Save results to save the calculation result to harddisk. The Automatic treemaker 

creates a subdirectory hrvfd. Enter TiltTable.mat as filename. 

 

10. Start the calculation. g.Result2D opens automatically with the calculation result: 
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11. Perform the same calculation for the second part of the data (standing period). Enter under 

Start interval at 634 seconds and under End at 1490 seconds.  

 

12. Change the filename to TiltTable1.mat and Start the calculation. 
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13. g.Result2D opens with the result: 
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The following code show how to perform the example demonstrated above from the 

MATLAB command line. 

 
%Load Data 

P_C=data; 

File=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\DataCorrected.mat']; 

P_C=load(P_C,File); 

 

%HRV frequency domain 

MarkerName='QRS'; 

Interval=[1  161792]; 

TachogramSampling=[2]; 

CorrectIntervals=[60  140]; 

F=[0.003        0.04        0.15         0.4]; 

Method='Burg'; 

NFFT=[256]; 

Overlap=[0]; 

Order=[10]; 

Window=['hanning']; 

FileName=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\TiltTable.mat']; 

ProgressBarFlag=0; 

[H_O]=gBShrvfrequencydomain(P_C,MarkerName,Interval,... 

CorrectIntervals,TachogramSampling,Method,NFFT,Overlap,Window,... 

Order,F,FileName,ProgressBarFlag); 

 

%HRV frequency domain 

MarkerName='QRS'; 

Interval=[162304  381440]; 

TachogramSampling=[2]; 

CorrectIntervals=[60  140]; 

F=[0.003        0.04        0.15         0.4]; 

Method='Burg'; 

NFFT=[256]; 

Overlap=[0]; 

Order=[10]; 

Window=['hanning']; 

FileName=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\TiltTable1.mat']; 

ProgressBarFlag=0; 

[H_O]=gBShrvfrequencydomain(P_C,MarkerName,Interval,... 

CorrectIntervals,TachogramSampling,Method,NFFT,Overlap,Window,... 

Order,F,FileName,ProgressBarFlag); 
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Heart Rate Variability Maps 
 

To simplify the data analysis and interpretation of the ECG data HRV Maps allow to estimate 

the temporal evolution of PSD. Therefore the PSD is computed within a certain segment. 

Then the segment is shifted by a specific stepsize and the PSD is calculated again. This is 

done until the end of the data-set is reached. The resulting plot shows the power distribution 

over the whole recording time. High power values are displayed color coded red, low power 

values are displayed color coded blue. 

 

HRV Map Window 

 

The HRV Frequency Domain window has the following control elements: 

 

Use complex marker – define the marker that is already assigned to the QRS complexes 

(manually or with the Complex Detector) 

 

Specify DATA INTERVAL: 

 

Start interval at – define the start time point for the calculation 

End at – define the end point of the interval used for the calculation 

 

Specify PSD INTERVAL: 

Interval length – defines the spectral analysis segments that contribute to one time 

point in the HRV map 

Stepsize – defines the stepsize for shifting the spectral analysis window over the data 

set 

 

Tachogram sampling frequency – the RR intervals are resampled with the defined sampling 

rate before the spectral analysis is performed. 

 

Correct RR-intervals: 

 

Min – a QRS complex is only accepted if the actual RR interval is not  

smaller than e.g. 60 % of the average interval 

Max – the complex is rejected if the RR interval is longer than e.g. 140 % of the 

average interval 

 

ULF – calculate the power in the ultra low frequency band (e.g. 0.003 Hz) 

VLF - very low frequency band (0.003 – 0.04 Hz) 

LF – low frequency band (0.04 – 0.15 Hz) 

HF – high frequency band (0.15 – 0.4 Hz) 

 

Method – the spectral analysis method can be FFT (non-parametric) or Burg, Yule Waker or 

Music (parametric methods). 

NFFT – specify the FFT points used for the spectral analysis for the non-parametric and 

parametric methods 

Overlap – specify the FFT segment overlap for the FFT analysis 

Order – specify the autoregressive model order for the parametric methods 
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Windowing function – select a hanning, hamming or boxcar window for the FFT 

analysis 

 

Example 

 

1. Click on Load Data from the File menu and select the file DataCorrected.mat from 
 
Documents\gtec\gBSanalyze\testdata\TiltTable 
 

The Data Editor shows an ECG channel with already assign QRS markers. 
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2. Open the HRV Map window from the ECG menu and select under Use complex marker 

QRS. 

 

 

3. Select the total data-set under Specify DATA INTERVAL for the analysis. 

 

4. Enter an Interval length of 128 samples as data segment length for the spectral analysis. 

Set the Stepsize of the data segment to 1 sample. These settings shift the 128 sample 
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window by 1 sample until the end of the data-set. 

 

5. Check the Correct RR-intervals box to eliminate intervals which are below 60 % or 

above 140 % of the average interval. 

 

6. Enter under ULF 0.003 Hz, under VLF 0.04 Hz, under LF 0.15 Hz and under HF 0.4 

Hz. 

 

7. Select the parametric Method Burg with an NFFT length of 256 samples and an Order 

of 10. 

 

8. Check Show with Result2D to open the graphical output of the calculation with 

g.Result2D. 

 

9. Check Save results to save the calculation result to harddisk. The Automatic treemaker 

creates a subdirectory hrvmap. Enter TiltTable.mat as filename. 

 

10. Start the calculation. g.Result2D opens automatically with the calculation result: 

 

 

The top plot shows the power spectral density evolution from second 0 to second 1490. 

The subject was standing up at second 620 which can clearly be seen in the data. The 

middle-left plot is the de-trended RR interval curve in ms. The bottom-left curve and the 

middle right curve are the time courses of the LF and HF parameters in ms2. The bottom 

right curve is the LF/HF quotient. 
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The following code show how to perform the example demonstrated above from the 

MATLAB command line. 

 
%Load data 

P_C=data; 

File=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\DataCorrected.mat']; 

P_C=load(P_C,File); 

 

%HRV map 

MarkerName='QRS'; 

Interval=[1  381568]; 

IntervalLength=[128]; 

StepSize=[1]; 

TachogramSampling=[2]; 

CorrectIntervals=[60  140]; 

F=[0.003        0.04        0.15         0.4]; 

Method='Burg'; 

NFFT=[256]; 

Overlap=[0]; 

Order=[10]; 

Window=['hanning']; 

FileName=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\TiltTable.mat']; 

ProgressBarFlag=0; 

[H_O]=gBShrvmap(P_C,MarkerName,Interval,CorrectIntervals,... 

TachogramSampling,Method,NFFT,Overlap,Window,Order,F,... 

IntervalLength,StepSize,FileName,ProgressBarFlag); 
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Event Related ECG 
 

This function calculates heart rate variability parameters before and after trigger events for a 

certain interval With Time before stimulus and Time after stimulus the time range for the 

calculation can be defined. Additionally a delay can be defined with Delay before stimulus 

and Delay after stimulus. 

 

If incomplete intervals defined with the settings above should be considered for calculation, 

select the Accept incomplete intervals checkbox. 

 

The function need assigned QRS markers and markers that indicate the trigger points. The 

corresponding trigger marker respectively QRS marker can be selected with the popup menus 

Trigger marker for the stimulus and QRS marker for the marked QRS complexes. 

 

The user can select:  

 

Heart rate Parameters 

 

 MEAN:  mean of the heart rate [bpm] 

 MEDIAN: median of the heat rate [bpm] 

 STD:   standard deviation of the heart rate [bpm] 

 RMSSD:  the square root of the mean of the square of differences between 

adjacent RR intervals [ms] 

 SDSD: the standard deviation of differences between adjacent RR 

intervals [ms] 

 NNx:  number of RR intervals differing by more than x ms to the next 

RR interval 

 pNNx:  NNx divided by the total number of RR intervals [%] 

 

The time x is set in ms, for humans the value is usually 50 ms.  

Example: 
 
Perform the following steps: 

1. Load data-set DataCorrected.mat under 

 
Documents\gtec\gBSanalyze\testdata\TiltTable 
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2. Click on Event Related ECG under the ECG menu to open the following window: 

 

 
 

3. Specify the Interval. Set the Time before stimulus to 10000 ms and the Time after 

stimulus to 10000 ms. 

4. Select Accept incomplete intervals. 

5. Select as Trigger marker TRIGGER and as QRS marker QRS. 

6. Check all checkboxes in the Specify METHOD section and select for x 50 ms.  

7. Press Start. 
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The MATLAB Editor shows the ASCII description of the result. The first and second 

columns of the matrix show the Trigger marker time point in seconds and samples. The third 

column represents the calculated values of the selected Method (e.g. MEAN) of all reference 

intervals. The next column shows the calculated values of all active intervals. 

 
Event related ECG Results: 

  
Input File: Z:\Guger\gBSanalyze\testdata\TiltTable\DataCorrected.mat 
Generated: 29-Apr-2011 17:6:4 

  
QRS Marker Name:     QRS 
Trigger Marker Name: TRIGGER 

  
Time before stimulus (reference interval):   10.000 s  (2560 samples) 
Time after stimulus (active intervall):      10.000 s  (2560 samples) 

  
Delay before stimulus:    0.000 s  (0 samples) 
Delay after stimulus:     0.000 s  (0 samples) 

  
Accept incomplete calculation intervals is enabled 

  
Calculation Method: MEAN 

  
Trigger |  Time [s] | Time [samples] |     Mean of reference |     Mean of 

active  
Number  |           |                |        interval [bpm] |     interval 

[bpm] 
---------------------------------------------------------------------------

------ 
      1 |    47.531 |          12168 |                 57.75 |              

52.78 
      2 |   633.563 |         162192 |                 59.11 |              

78.14 
      3 |   841.770 |         215493 |                 72.71 |              

73.80 
 

 

The following code show how to perform the example demonstrated above from the 

MATLAB command line. 

%Load Data 

P_C=data; 

File=['C:\Users\' getenv('USERNAME') 

'\Documents\gtec\gBSanalyze\testdata\TiltTable\DataCorrected.mat']; 

P_C=load(P_C,File); 

 

%Event Related ECG: 

SamplesBefore = [2560]; 

SamplesAfter = [2560]; 

DelayBefore = [0]; 

DelayAfter = [0]; 

AcptIncomplete = [1]; 

TriggerMarkerName = 'TRIGGER'; 

QRSMarkerName = 'QRS'; 

Method = {'MEAN';'MEDIAN';'STD';'RMSSD';'SDSD';'NN50';'pNN50'}; 

FileName = ''; 

ProgressBarFlag = [1]; 

E_O = gBSeventrelatedecg(P_C,SamplesBefore,SamplesAfter,DelayBefore,... 
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DelayAfter,AcptIncomplete,TriggerMarkerName,QRSMarkerName,Method,... 

FileName,ProgressBarFlag); 

Help 

g.BSanalyze and the g.ECGtoolbox provide a printable documentation and a function help. 

 

The printable documentation is stored under  

C:\Program Files\gtec\gBSanalyze\Help 

 

as gECGtoolbox.pdf. Use Acrobat Reader to view the documentation. 

 

 

To view the function help type 

 
help gBSfunctionname 

 

under the MATLAB command window.  

To view all functions that are available in batch mode type 

gBSfunctions 
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Batch Mode 

The easiest way to create a batch for data processing is to perform the analysis under the Data 

Editor using the graphical user interfaces. Make sure that the Show diary checkbox is enabled 

in Appearance Settings under the Options menu. 

 

 

 

This forces g.BSanalyze to report all calculations in the MATLAB command window. After 

finishing the analysis open a New Script and copy and paste all commands into the file. 
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Save the batch in your own directory as mybatch.m and start the batch under the MATLAB 

command window with 

mybatch 

In order to investigate further data-sets just replace the input data file by the new data file to 

perform the same analysis. 
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Product Page 

Please visit our homepage www.gtec.at for 

 Update announcements 

 Downloads 

 Troubleshooting 

 Additional demonstrations 

http://www.gtec.at/
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